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• What is a poster session?  
• What is a scientific poster? 
• Planning 
• What should be on a scientific poster? 
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A good poster can’t make up for bad 
research,  
but a bad poster can make good research 
hard to recognize! 
 
 
 
• http://www.waspacegrant.org/for_students/student_internships/wsgc_internships/posterdesign.html 

POSTER SESSION?  

SCIENTIFIC POSTER? 

“Criticism and testing are of the essence of our work.   

This means that science is a fundamentally social activity, which implies that 
it depends on good communication.” 

                                     -Hermann Bondi - Quoted by Robert A. Day in How to Write & Publish a Scientific Paper. The 

Oryx Press (1998)  p. ix. 
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Poster session? 

• Definition educause (http://www.educause.edu/):  
 Poster sessions are informal, drop-in sessions that 

allow presenters to share their (campus) experiences 
with colleagues on a one-to-one basis. Poster 
presenters should be prepared to provide a brief verbal 

explanation of their experiences or applications that 
may be illustrated through a set of visuals attached to a 
large bulletin board or via laptops/screens, etc 

• Other important elements: 
– Location 

– Poster stand 

 

Poster session: goal 

• Share research (results, idea, …)  
• Stimulate discussion  on a research topic  
• Feedback on research 
• Networking 

 

http://www.educause.edu/
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Poster session: informal, drop-in 

• Informal, drop-in 

– Less formal than a presentation 
– Walking audience 
– Try to catch the attention 
– Message has to be transferred in a fast and clear way 

 

Poster session: one-one basis 

• One-one basis 

– Ideal for discussion  
– Conversation can get more in-depth 
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Poster session: short presentation 

• Short presentation 

– Poster can (may) not contain all details 
– Conversation / presentation can go into detail 
– Poster must be self-contained 

Poster session: visual 

• Visual 

– Advertisement for your research 
– Eye-candy 
– Lure, seduce the audience with a flashy title, charts, … 
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Poster session: location 

PLANNING 
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Scientific poster: planning 

• READ THE INSTRUCTIONS 

– Dimensions 
• 1 large poster  
• individual A4 pages 

– Specification: dimension images, portrait/landscape, font, 
numbering poster, …. 

– Additional requirements? 
Tape, pushpin, … 

• Check Judging criteria  
• Try to get as much information on the poster session as 

possible 
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Judging Criteria for Poster Presentation (www.ncl.ac.uk/fms/postgrad) 
   
First Impression:  How difficult is it to read the poster? 
   How are colour schemes used, are they easy on the eye? 
   How crowded is the poster? 
   Is there a good flow of information (logical, layout of information)? 
   Does the poster stimulate interest and discussion? 
 Layout:  Is the poster visually jumbled? 
   How easy is it to follow the sequence in the poster? 
 Readability:  Is font size or style easily readable? 
   How much text does the poster contain? 
   Are there many grammar or spelling mistakes? 
 Title:  How specific/adequate/long/short is the title? 
 Identification:  Can the author(s) be easily identified? 
   Is contact information available (ie. Department/ University) 
 Aims/ Objectives: Are they clearly stated? 
 Methods:  How detailed, appropriate, original are the methods and is there enough explanation? 
 Results:  How clear and well labelled are graphs and figures? 
   How complex are graphs? 
   How well are the results presented? 
 Conclusions:  Are any conclusions presented and if so do they reflect the aims and are they supported by the 

  data? 
   Is there a memorable “take-home” message? 
 Scientific content: Was the research put into broader context/ justification for research? 
   Was the content suitable for experts and non-experts alike? 
   Was there sufficient scientific explanation? 
 Student:  How much do the student’s explanations demonstrate knowledge/ ownership/ enthusiasm for 

  his/her work? 
 

• Provide enough time 
– Do not postpone to the 

last minute 
– Murphy will be there… 

• Get colleagues / friends 
/ family to check / 
brainstorm the poster 

Poster presentation 
• 1 week: print final poster  
• 2 weeks: 

– 2nd draft 
– Check with promotor   

• 3 weeks:  
– 1st draft 
– Review-Review-Review; 

give it a rest 
• 4 weeks:  

– List must have and  
leave out   

– Layout design 

Scientific poster: planning (ideal world) 
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• Start from scratch 
– Do not make a summary of a paper 
– Do not start from an existing presentation / slideshow  

• Make a clear choice on the essentials : 
– What problem(s) are tackled?    (Objectives) 
– Why is this important?     (Background)  
– How did I do it?     (Methods)  
– What are the results?     (Results)  
– What is the conclusion(s), implication(s)?   (Conclusion)  
 
(should be in the abstract) 

 

Scientific poster: planning 

• Poster = illustrated abstract 
• LESS IS BEST – LESS IS MORE 

Scientific poster: planning 

http://www.cns.cornell.edu/documents/ScientificPosters.pdf 
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• Audience? 
– Who is my audience? 

• Colleague competitor 
• Colleagues from the same domain 
• Colleagues outside domain 

– What does the audience know about my research? 
– What does the audience want to know about my 

research 
• Make a storyboard 

– What is the message that I want the audience to 
remember? 

– What is the logical order to bring the message?  
– How to convey the message?  

 

Scientific poster: planning 

Critique from colleagues / outsiders   
• Is the poster audience friendly? 

Is the poster suited for the audience? 
• Is title short and powerful, a reflection of the research? 
• Do the objectives correspond with the content of the 

poster? 
• Are the methods used well explained, understandable? 

Do they correspond with the conclusions/ 
objectives? 

• Are the conclusions strong enough? 
• Is the language used clear, free of any  

jargon? 
 
www.postgraduate.uwa.edu.au 

Review, review, review: content 

http://www.postgraduate.uwa.edu.au/
http://www.postgraduate.uwa.edu.au/
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Review, review, review: format 

• Are the dimensions / shape correct? 
• Is it readable from a distance (2-5 meter)? 
• Is the layout ok,  not too messy, consistent? 
• Typos? Other errors? 

ELEMENTS 
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Elements 

• Title 
• Author(s) + affiliation 
• Abstract/Introduction 
• Method(s) 
• Data/results 
• Conclusion(s) 
• References 
• Acknowledgements 
 

 

Element: title 

• Must be very interesting (provocative…) 
• Audience must be tempted from a distance 
• Visible and readable at 5 m 
• Concise 

– If too long, make it shorter, reformulate 
– Do not decrease the font size 
– Avoid the use of ‘:’ 
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Element: title 

Compare: 
• "A Study of Automobile 

Emissions Generated at 
Drive Up Windows"  

• "5% of Air Pollution 
Derives from Cars Idling 
at Drive Up Windows"  

• "Drivers Spend an 
Average of 7.2 Minutes 
Idling at Drive Up 
Windows“ 

 

Element: authors/affiliation 

• Write the first name in full 
– Initials and titles are not needed 
– A photo of the person who is presenting the poster, or highlight 

the name 
– Check with promotor on the order of the collaborators 

• Do not forget the affiliation 
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Element: abstract / introduction 

• Emphasize a few important points 
must be a help to the structure of the poster 

• Essential points / positioning the research 
• Explains why this work is important 
• 150 – 200 words 
 
• Complete Clear Concise Cohesive 

Element: data/results – text  

• KISS (keep it short and simple) 
• Remove all non-essential information 
• Avoid footnotes 
• Avoid abbreviations, acronyms, jargon 
• Use no more than 1000 words  
• Use charts as visual eye-candy 
• Rule-of-thumb: 

• 20% text 
• 40% graphics 
• 40% space 

• Format is domain dependent (mechanical engineering <> 
sociology) 
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Element: data/results - text 

• Original  
The ideal anesthetic 
should quickly make the 
patient unconscious but 
allow a quick return to 
consciousness, have few 
side effects, and be safe 
to handle.  
 

• Poster version 
 Ideal anesthetics 

– Quick sedation  
– Quick recovery 
– Few side effects 
– Safe to handle  

 

Element: data/results - text 

• Better, still some room for 
improvement 

• Too much text 
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Element: data/results - charts 

• Table:  
– Limited number of data 
– Label columns 

• Charts: 
– Large set of data points 
– Do not forget to label plots, axes, … 

• Charts must be readable at a distance of 2 m! 
• Get all the charts in a uniform way, size 

Element: conclusion 

• Important part of the poster  
• Emphasize the important/strong points 
• New insights/interpretations  
• Use bullets to distinguish the different elements 
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Element: acknowledgements / references 

• Acknowledgements 

– Funding,  
– Who was helping you out with your research 

• References 

– Only the important  – no literature study 
– Can be expanded during conversation 

 

POSTER PRESENTATION 
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Poster session: tips 

• Handout (poster, paper) 
• Business card  
• Candy?! 
• Dress?! 

• transport poster 
• Carrying case 
• hand-luggage 
• Cissors, tape 

• take pdf file 

Poster session: tips 
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www 

• Colin Purrington 
http://colinpurrington.com/tips/academic/posterdesign 

• George Hess, Kathryn Tosney, Leon Liegel 
http://www.ncsu.edu/project/posters 

• Cornell 
http://www.cns.cornell.edu/documents/ScientificPosters.pdf 

• Eposters 
http://www.eposters.net/ 
 

 

Thank you 

• www.flickr.com - Creative Commons-licensed content 
• http://colinpurrington.com/tips/academic/posterdesign 
• http://www.ncsu.edu/project/posters 
• http://www.cns.cornell.edu/documents/ScientificPosters.pdf   

http://colinpurrington.com/tips/academic/posterdesign
http://colinpurrington.com/tips/academic/posterdesign
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Scientific Posters 
Production 

 
tips & tricks 

 
Frank Van Puyvelde 

ICTS 

Content 

 
 
 
 

• Production: using PowerPoint 
• SOS Poster 
• Poster Printing 
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PRODUCTION 

Note for technophfobes 

Cut-and-Paste 
– Print separate A4’s and glue it together 

• Useful at the design stage 
• Fast, simple 
• Not always a success 
• In emergency only 
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Note for technophfobes 

• Do not use WORD! 
– Works well for A4, enlarging to A0 is disappointing 
– Difficult to get it printed on a large format 

• Convert a PowerPoint presentation to a poster 
– 100% bad result 

 
 

PowerPoint?! 

+ 
• Easy to start with 
• Available 
• Common use 
• Office-suite 
• Templates available 

- 
• Presentation software, not designed for posters 
• Printing can be a problem 
• Illustrator, Corel Draw, … are more powerful, but at a 

price of a steeper learning curve 
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Get ready 

• Have all the information bits collected before starting 
the powerpoint poster. 

• Collect all information in 1 folder (source code) 
– images 
– graphics 
– text 

• Get the layout on paper 
 

Poster layout: inspiration or template? 

• Some organizations have their own template 
• Department can have a template 
• Dienst communicatie 

www.kuleuven.be/communicatie/poster_powerpoint.html 
– Standard template 
– Scientific posters 
– Note: no white borders allowed! 

• Web:  
– www.posterpresentations.com/html/free_poster_templates.html 
– www.medmediasolutions.com/poster_templates.shtml 
– … 

• Eposters: online journal for scientific posters 
www.eposters.net 
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PowerPoint 2007 - settings 

• Click Office button and select PowerPoint Options 

• Save: embed fonts – all characters 
• extra fonts: www.searchfreefonts.com 

PowerPoint 2010 - settings 

• Click File button and select Options 

• Save: embed fonts – all characters 
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Fonts enclosed? 

Dimensions poster 

• Immediately set the final 
dimensions (changing 
dimensions afterwards may 
ruin the layout)  

• Note: 
– Limit the size of your poster (2 

m high posters are difficult to 
read!) 

– Do not make a larger poster 
than provided for 

– A0 (84*118 cm), Oversize A0 
(90*125 cm) most used 

– PowerPoint: limited to 
1.34/1.42m 
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Table of Paper Sizes 

Size Height x Width (mm) 

4A0 2378 x 1682 mm 
2A0 1682 x 1189 mm 
A0 1189 x 841 mm 
A1 841 x 594 mm 
A2 594 x 420 mm 
A3 420 x 297 mm 
A4 297 x 210 mm 
A5 210 x 148 mm 
A6 148 x 105 mm 
A7 105 x 74 mm 
A8 74 x 52 mm 
A9 52 x 37 mm 
A10 37 x 26 mm 

Page size 

• Set the final dimensions immediately 
• Portrait / landscape 
• Ontwerpen > Pagina-instelling 

(Design > Page Setup) 
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Dimensions poster 

• Check with the organization for available space 

Ruler & guides 

• Ruler and guides are very helpful to place the objects 
• Beeld > Liniaal (View > Ruler) 

• Right click on slide, select ruler, grid 

and guides(liniaal raster en hulplijnen)  

• Move the guide, make a new one with ctrl 
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Zoom 

• Do not forget to have a 100% view of the poster 
• Use the zoom tool 

 

Poster layout 

• Start by sketching a layout on paper 
 

• Read a poster as a newspaper 
 

• Use columns, try to place the important points at eye 
level 
 

 Title 

Intro 

Conclusion 
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Poster layout 

• Use  3 to 5 columns (landscape) 
1 tot 3 columns (portrait) 

• Order the elements vertically from upper left to lower 
right 

• Order the object logically 
• Use sections 
• Add graphics, tables, images 
• Number sections or use visuals to guide the reader 

Poster layout 

text 
• text 
• text 

text 
• text 
• text 

text 
• text 
• text 

text 

text 

text text 

text 

•  SmartArt can help 
•  Caution: Boring uniformity 
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Font: dimensions (lower bound) 

• Title:   96 pt 
• Author:  72 pt 
• Affiliation:  36-48 pt 
• Section header: 36 pt 
• Text:  24 pt 

 
• Use standard fonts  

less problems when printing 
• Easy to read: 

Arial, Calibri, Tahoma, 
Verdana 
 
 

 

Font 
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Title 

Title 
• < 6 words, capital letters only allowed 
• Careful with capital letters only, too busy 

Text 

• Emphasis  
– Use bold instead underline. – use moderately -  
– Use different font, fontsize,  color  
– Avoid italics  

• Be uniform, consistent in dimensions, style and font 
 

•   
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Text: emphasis 

2. What are Singlet States? 

Consider a system with two spin 1/2 nuclei with 
identical resonancefrequencies. The matrix 
representation of the spin Hamiltonian is not 
diagonal in the Zeeman product basis, indicating 
that the Zeeman product states |!!>, |!">, |"!> and 
|""> are not all eigenstates of the Hamiltonian, H. By 
selecting a different basis, called the singlet-triplet 
basis, the Hamiltonian is diagonalized. The triplet 
states are: 

|T+1>= |!!> 
|T0 > = 1/!!"|!">+ |"!>) 

|T-1> = |""> 
And the singlet state is: 

|S0> = 1/!!"|!">- |"!>) 
The important feature of this system is that the 
singlet state is a  completely disconnected 
eigenstate [3]. 

<S0|H|T0> = 1/2(<!"| - |"!>) H (<!"| + |"!>) = 0 
Thus, populations in the singlet state are trapped 
and there are no allowed transitions in or out of the 
singlet state. The result is that hyperpolarized 
populations in the singlet state are stored and their 
lifetime increased. 

2. What are Singlet States? 

Consider a system with two spin 1/2 nuclei with 
identical resonancefrequencies. The matrix 
representation of the spin Hamiltonian is not 
diagonal in the Zeeman product basis, indicating 
that the Zeeman product states |!!>, |!">, |"!> and 
|""> are not all eigenstates of the Hamiltonian, H. 
By selecting a different basis, called the singlet-
triplet basis, the Hamiltonian is diagonalized. The 
triplet states are: 
 |T+1>= |!!> 
 |T0 > = 1/!!"|!">+ |"!>) 
 |T-1> = |""> 
And the singlet state is: 
 |S0> = 1/!!"|!">- |"!>) 
The important feature of this system is that the 
singlet state is a  completely disconnected 

eigenstate [3]. 
         <S0|H|T0> = 1/2(<!"| - |"!>) H (<!"| + |"!>) = 0 
Thus, populations in the singlet state are trapped 
and there are no allowed transitions in or out of the 
singlet state. The result is that hyperpolarized 
populations in the singlet state are stored and their 
lifetime increased. 

vis.duke.edu/scientific_poster_workshop 

Text 

• Align 
– Align (text and text blocks) 

provides a sense of order 
– Align left, do not use justify 

• Layout 
– 7-8 words per line 
– Limit the size of a text line, make it easy for the reader 
– Keep the same column width 
– Use space 
– Use bullets 
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Align: center 

Align: justify 
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Align: left 

Text 

• 2 ways: 
– Start text box and let it grow as you type 
– Fix the width of a textbox (drag a text box and set the width) 
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Charts 

• Get the correct representation 
• Useful info: 

– www.juiceanalytics.com/writing/chart-selection-art-and-science/ 
– www.juiceanalytics.com/chart-chooser/ 
– www.ncsu.edu/labwrite/res/gh/gh-graphtype.html 

What chart? 
• Andrew Abela: extremepresentation.typepad.com/blog/2006/09/choosing_a_good.html 
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Charts 

• Background usually has 
no added value 

• Put information near the 
plot, no legend 

• No gridlines 
• Y-label horizontally 

 

Charts 

• Avoid 3D-charts if possible 

http://www.presentationzen.com/presentationzen/2007/03/a_few_weeks_ago.html 
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Charts powerpoint  

• Start from scratch within PowerPoint 
• Insert > Chart (Invoegen > Diagram) 

Make a choice and spreadsheet opens 
 

 

Charts excel 

• Transfer from Excel can sometimes cause problems 
• Copy chart in Excel 
• Paste Kies optie (Plakken)(in Home menu) 

• Paste special (plakken speciaal) > 

preference for importing as a png 
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Charts 

• When putting charts from different sources (matlab, 
SAS, sigmaplot, Excel, …): 
– try to be uniform 
– Import as pictures 

 

Images 

• Useful information: http://it.med.harvard.edu/ris 
• Get the correct resolution 

– No web images 
• resolution tool low 
• Copyright (flikr.com - Only search within Creative Commons-licensed 

content)  

– No overkill on resolution (scan, digital pictures) 300 - 600 dpi 
– Avoid clip-art 
– Process images outside powerpoint (photoshop, gimp, 

pixlr.com) 

• Dimensions 
– Keep aspect ratio (lock aspect ratio) 
– Inspect at full size (100%)  

• Use the right type (png, tiff, jpeg) 
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Images 

• Do not forget: 
– Legend 
– Scale 

• Images with a small border  
seem to look better 

Images 

ppi – pixels per inch (72ppi, 150ppi, 
300ppi). 

Pixel dimension – how many pixels 
in the image 
(640 x 480, 1200 x 1600). 

File size – how much space is 
taken bij the file (14K, 227K, 
6MB). 

Picture size – dimension of the 
picture (4x6, 5x7) 
 

Valerie Griffith (ucdavis – powerup with powerpoint) 
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Images 

72 ppi 
1 inch square 

150 ppi 
1 inch square 

300 ppi 
1 inch square 

 

Valerie Griffith (ucdavis – powerup with powerpoint) 
 

Images 

• Inert: 
– Use insert menu (best choice) 
– Copy/paste 

• Image can be edited further 
Picture tools > format  

(Opmaak menu binnen hulpmiddelen voor 

afbeeldingen) 
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Images 

• Selecteer: 
• lock aspect ratio 
• Relative to original picture size 

Logo 

• K.U.Leuven logo’s: 
www.kuleuven.be/communicatie/logo_zegel.html/ 

• Take care: 
– Resolution 
– Transparancy 
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sedes 

• Tip: change background (Powerpoint 2010) 
• Insert sedes.eps (insert > picture) 
• Select sedes, choose ‘Picture Tools – Format’ > Color > 

Set Transparent Color > click the transparency tooltip 
on the image 

Align tool 

• Use align tool to align different objects on the poster 
– Select objects 
– Align 

 
 
 
 
 
 
 
 

• Use guides 
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Color 

• Use 1 background color 
– Take a light color 
– Avoid the standard PowerPoint textures 
– Dark backgrounds tend to use a lot of ink (paper curl) 

• Limit the color pallet, no coloring page 
• Use colors in a consistent way 

 

http://www.paper-leaf.com/blog/wp-content/uploads/2010/01/ColorTheory_Screen_White.jpg 
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Color 

• White background will reduce 
the impact of bright colors  

• Grey background will enhance 
bright colors 

Color: gradient, transparency 

Gradient 

• Be careful 
• Print can be bad 

(banding) 

Transparency 

• Print can be a problem 
• As well in corel as ppt 
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Transparency 

• Symptom: bad print quality – lines, dot pattern instead 
of transparency 

• Solution 1: avoid transparency, shadow, gradients 
• Workaround: transform to an image  

(www.print-service.dept.shef.ac.uk) 
1. Select the objects (CTRL to select different objects) 
2. Group objects together (format > group) 
3. Cut the object (CTRL-X) 
4. Clipboard menu: choose Paste Special 
5. Choose object format (PNG gives good results) 
6. Place the image 
support.microsoft.com/kb/815001/en-us 

Transparency 
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Transparency 

Color: background image 

• Usually disappoints 
• Keep it really on the background! 
• Print can be a problem (transparency) 



28 

Background 

• grays and muted/pale colors help foreground 
information standout (cool colors) 

• Keep backgrounds subtle; no busy backgrounds 
• Different options in PowerPoint 
• Design > Themes(Ontwerpen > Thema’s)  

• Background Styles(Ontwerpen > 

Achtergrondstijlen > Achtergrond opmaken)  

 

Background 

• Picture in background 
• Achtergrond opmaken > Opvulling met 

figuur 

(Format Background > Picture fill) 

• Change transparency 
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Contrast 

• Text blocks on white or 
pale background, dark 
fonts 

• Use dark background / 
light letters for title, 
section headers  

• Color blindness?! 
Red/green combinations 
 http://www.vischeck.com/vischeck/vischeckImage.php 

 

Contrast 

•Solid 
•Gradient 
•Photograph 
•Graphic 

•Solid 
•Gradient 
•Photograph 
•Graphic 

•Solid 
•Gradient 
•Photograph 
•Graphic 

• Use clear contrasts 
• Text shadow can disappoint 
• Must be legible at 2m  
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Color: print 

• The color on the computer screen is not the color that 
will be printed! 

• Range screen > range printer 
 
 
 
 
 

• Red, Green, and Blue are "additive colors“ 
• Cyan, Magenta and Yellow are  

"subtractive colors".  

PDF 

• ICTS plotter service 
admin.kuleuven.be/icts/services/plotter/ 

• Submit a poster as PDF  
• Important: 

– Poster in PDF should have the correct dimensions 
– Check the PDF file (is everything on the poster, typo’s, …) 

• Print dimensions: print on a roll 90 cm width!  
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PDF – Microsoft 2010 - saveas 

• Menu: File  
• Save As > PDF  
• Save as type choose PDF.  

PDF – Microsoft 2007 - saveas 

Seems to give good results 
• Microsoft Office Button, 

select Save As > PDF or XPS 

(Opslaan als > PDF of XPS) 
• Save as type (Opslaan als 

type) choose PDF.  
• Optimize for (Optimaliseren 

voor): Standard 
• More options: do not use 

PDF/A (transparency problems) 
• Publish (Publiceren) 
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PDF – adobe - print 

• If Adobe Acrobat is installed – this 
should give the best result – from 
version 8 on 

• Microsoft Office Button, select Print 

(Afdrukken) 
• Choose Adobe PDF from the list and 

change Properties (Eigenschappen) 
• Settings:  

– High quality 
– Setthe correct page size 

• check Scale to fit paper (Aanpassen 

aan papierformaat)  

• OK 
 
 
 

PDF – cutePDF - print 

• If cutePDF is installed 
• Microsoft Office Button, select 

Print (Afdrukken) 
• Choose cutePDF from the list and 

change (Properties) 

(Eigenschappen) 
• Advanced settings 

(Geavanceerde Instellingen) :  
– Download font 
– Set correct page size 

• Check Scale to fit paper 

(Aanpassen aan papierformaat) 

• OK 
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Transfer the poster 

• More info on  
admin.kuleuven.be/icts/services/plotter/ftp-transfer_en.html 

Problems? 

• Try to use only 1 computer 
• Stick with 1 software version 
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DESIGN PRINCIPES 

Principles of Graphic Design 

Source: 
• en.wikipedia.org/wiki/Design_elements_and_principles 
• www.johnlovett.com/test.htm 
• Graphic Design Tutorial | eHow.com 
• Williams, Robin. The Non-Designer’s Design Book: Design and 

Typographic Principles for the Visual Novice. 2nd edition. Berkley, 
California: Peachpit Press, 2004. 
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Principles of Graphic Design 

• Balance/symmetry: visually balance color, objects, 
shapes, … 
– Make it aesthetically pleasing 
– Symmetric: static 
– Asymmetric: dynamic 
– Radial 

 

Principles of Graphic Design 

•Symmetric 
•Asymmetric 
•Radial 
desktoppub.about.com/cs/graphicdesign/a/designbasics.htm 
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Principles of Graphic Design 

• Emphasis: put an object on foreground, other color, 
change size, more ornaments, … 
 

http://artsalive.ca/collections/posters/search_details.php?id_poster=90&lang=en 

Principles of Graphic Design 

• CRAP 
– Contrast:  

“If two items are not exactly the same, then make them 
different. Really different.”  

– Repetition 
“Repeat some aspect of the design throughout the entire piece.”  

– Alignment 
“Nothing should be placed on the page arbitrarily. Every item 
should have a visual connection with something else on the 
page.”  

– Proximity 
“Group related items together… so the related items are seen 
as one cohesive group rather than a bunch of unrelated bits.”  
 

http://www.nhsdesigns.com/principles/ 
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Principles of Graphic Design 

• Contrast: contrast in size, color, … 
• make a visual splash where parts of the page stand out. 

http://www.nhsdesigns.com/principles/contrast/page02.php 

Principles of Graphic Design 

• Repetition 
• Repetition focuses on consistency. 
• Repetition comes through unity and consistency in font, 

alignment, headings, etc 
 

http://www.nhsdesigns.com/principles/repetition/poster-assignment.php 
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Principles of Graphic Design 

• Alignment: for text as wall as for graphical objects. 
Gives a neat, orderly design 

• Alignment focuses on unity. 
• There needs to be something that ties together all of the 

elements of the page visually. 
 

www.nhsdesigns.com/principles/alignment 

Principles of Graphic Design 

• Proximity: focuses on clarity in organization. 
• Related items placed in close proximity to each other 

appear as one visual unit, rather than several unique 
items. 

www.nhsdesigns.com/principles/proximity/ des1012.blogspot.com/2008/06/design-elements-principles-summary.html 
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Principles of Graphic Design 

• White space: can be used to give some structure. Be 
consistent: same spacing around images, charts, … 
 

http://www.ncsu.edu/project/posters/NewSite/ 

SOS POSTER 
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SOS Poster 

Ideal 

• Be seductive 
• Creative communication of 

research 
• Clear structure (flow) of 

information 
• Images and charts 

(visuals) instead of text  
• Initiate communication 
• Handouts can help 
 

Avoid 

• Paper on a poster format 
• Too much text 

– Only the essentials 
– Remove unnecessary 

details 

• Excess of color / 
combinations 

• Intense background 
 

•Align 
•Uniform 
•Balance 
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• Clear title 
• Large text box forms a 

unity 
• Images aligned 
• Pale colors are more eye 

friendly 
• Balanced by spreading the 

image and the chart 
http://www.fes.uwaterloo.ca/computing/help/posterdesign/PosterCreation.pdf 

• Title too small 
• Different text boxes do not 

form a unit 
• Contrast between dark 

background and white text 
box is too intense 

• Left part: too much text 

Examples (CCMR Cornell Center for Materials Research) 

• Trop is Teveel 
• exhausting 

• Contrast 
• Different 

backgrounds 
distract 
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Examples (CCMR Cornell Center for Materials Research) 

• Where to start? • Careful with standard 
PowerPoint background 

Examples (CCMR Cornell Center for Materials Research) 

• Dark background 
• Contrast 
• Gradient 
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Examples (CCMR Cornell Center for Materials Research) 

• Use gradients sparingly 

Examples (CCMR Cornell Center for Materials Research) 

• Simple 
• Balance ok 
• Clear distinct title logo 
• Clear flow 
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Examples (CCMR Cornell Center for Materials Research) 

• Color can help or not? 
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www 

• Colin Purrington 
http://colinpurrington.com/tips/academic/posterdesign 

• George Hess, Kathryn Tosney, Leon Liegel 
http://www.ncsu.edu/project/posters 

• Cornell 
http://www.cns.cornell.edu/documents/ScientificPosters.pdf 

• Eposters 
http://www.eposters.net/ 
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Thank you 

• www.flickr.com - Creative Commons-licensed content 
• http://colinpurrington.com/tips/academic/posterdesign  
• http://www.ncsu.edu/project/posters 
• http://www.cns.cornell.edu/documents/ScientificPosters.pdf   

Questions? 

• Contact: 
 Frank.VanPuyvelde@icts.kuleuven.be 
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